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INTRODUCTION

What  This  Manual  Is

This is the PC-MICAR User Manual. PC-MICAR is a cause-of-death data entry system
designed for editing and processing of medical information reported on a death certificate
in the United States. PC-MICAR requires a trained MICAR coder to use!

PC-MICAR is one part of the National Center for Health Statistic's Mortality Medical
Data System. NCHS began developing the system in 1967 to automate the entry,
classification, and retrieval of cause-of-death information reported on death certificates.
Mortality medical data is processed through four basic programs: PC-MICAR, MICAR1,
ACME2, and TRANSAX3.

• PC-MICAR PC system for MICAR data entry, including reporting procedures, full-
screen data entry and editing. PC-MICAR is designed to assist MICAR
data entry operators in encoding medical cause-of-death data into numeric
entity reference numbers (ERNs) in accordance with the rules expressed in
Part 2g of the Vital Statistics Instruction Manual (VSIM) series. PC-
MICAR output is used by later programs to classify causes of death to their
International Classification of Disease (ICD) codes. PC-MICAR only runs
on personal computers.

• MICAR Automates the multiple cause coding rules (see Parts 2b and 2e of the
VSIM series) and assigns ICD codes to each entity.

• ACME Applies World Health Organization (WHO) rules to the ICD codes
determined by MICAR and selects an underlying cause of death (see Part
2a and 2c of the VSIM series). ACME is available on both the mainframe
and the personal computer. On the PC, ACME and TRANSAX are
distributed as a single product.

                                                  
      Mortality Medical Indexing, Classification, and Retrieval

      Automated Classification of Medical Entities

      TRANSlation of AXis
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• TRANSAX Facilitates the tabulation and use of multiple cause-of-death data. Through
the application of the ICD linkage and modification rules, TRANSAX
translates the axis of classification from an entity to a record base.
TRANSAX is available on both the mainframe and the personal computer.

The only other manual specifically associated with this one is the PC-MICAR System
Manager's Manual. The System Manager's Manual contains information on the installation
and maintenance of the PC-MICAR software, as well as some utilities that may need to be
used.

Who  This  Manual  Is  For

This manual is intended for data entry personnel. It contains instructions on using
PC-MICAR to enter cause-of-death information and to process that information. Only
those sections of PC-MICAR that deal with data entry and processing operations are
addressed in this manual. It is organized on the assumption that the user has little or no
familiarity with PC-MICAR. Therefore, the subjects in this manual are arranged so the
user receives all of the instructions necessary to perform a given task at once.

Changes  in  1996

The 1996 version of PC-MICAR data entry software includes numerous changes from the
1995 and other previous versions. Many of the changes are easily apparent, and others
might go almost unnoticed. This section outlines the differences, so that you can quickly
familiarize yourself with them. For a graphical overview of the changes, a demonstration
of many of them has been provided on the installation diskettes. Refer to the installation
instructions in the PC-MICAR System Manager's Manual for information on installing and
running the PC-MICAR Data Entry 1996 demo.

The File System

The most fundamental difference in the 1996 version lies in how it handles files. In the
past, each file would contain a single batch of work, and each file could be either open or
closed. The open file was the one you were currently using. Closed files were stored in a
compressed format in the <BATCHES> directory. In 1996, the file format is changed.
Your batches are stored in a <DATA> subdirectory that you can specify through the
program. This directory can be on a network drive (See Network Compatibility, below).
Any file that exists in your data directory can be opened at any time. Thus, closing a
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batch does not include compressing it or moving it to another location. It merely closes
that file and allows you to open another one, or create a new one.

Files are also stored in a different database format. The new database files use a
Foxpro-compatible X-base database. Data files from previous versions of PC-MICAR
cannot be used by the new system, but can be converted by exporting the MICAR100
input file (the mainframe file) from the 1995 version and importing it into PC-MICAR
1996 using the Import MICAR 100 File option from the File menu. However, because of
changes in the 1996 external cause prompts, it is not advised to process data entered
through a prior system.

In addition, the entire MICAR data structure for all PC-based MICAR software
(Super-MICAR, PC-MICAR Data Entry, MICAR100/200, and PC-ACME/TRANSAX) has
been universalized. The data file that PC-MICAR creates contains provisions for storing
the data from all MICAR programs. Thus, you no longer need to generate a MICAR100
(mainframe) input file unless you are uploading to a mainframe for MICAR processing.
The PC versions of MICAR100 can read the same data file format that PC-MICAR uses,
as can PC-ACME/TRANSAX. While this causes the PC-MICAR database to be larger, the
space used by this system is made up in less need for ASCII files to transfer data between
systems. For more information on data sharing between the PC-based MICAR systems,
see the section The Unified Database in the PC-MICAR System Manager's Manual.

Network Compatibility

The new file system includes provisions for accessing data on network file servers. With
this ability, you can keep your files on a local area network, where they can be available
to multiple users at all times. As a part of this compatibility, each file is also multi-user
accessible. With this ability, multiple users can enter data into the same file
simultaneously. It is still recommended, however, that batches be kept small in order to
facilitate storing, shipping, and finding the proper files and records. By combining
network-compatible files, multi-user access, and multiple file availability, it is possible in
the new system to segment data in new ways. For example, it is possible to have one file
for each month, and enter all deaths for that month into a single file on a network drive. 

The Menu System

The most apparent change in PC-MICAR 1996 is the change from the menu list that was
used in earlier versions to the drop-down menu interface that is in the 1996 version. The
drop-down menus are easier to use, easier to navigate, and place all the options of
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PC-MICAR at the user's fingertips. The PC-MICAR 1996 Demo is primarily geared to
showing the menu system and how to access its functions. For more information on the
menu system, go through the demo, or read the section "Using the Menus" in this manual.

The Universal External Cause Prompts

PC-MICAR 1996 is the first system to collect and use the ICD9/ICD10 Universal Prompts
for External Causes. These are equivalent to the external cause prompts used in earlier
versions of PC-MICAR, but have been revised to make it possible to collect data for both
the 9th and 10th revisions of the International Classification of Disease. MICAR data
entry coders should familiarize themselves with the new prompts. These prompts are
provided in a PDF format with the installation disks, and will also be printed in the 1996
revision of the MICAR Instruction Manual Part 2g. There is a practice package included
with the installation disks, called Prompt10, to help coders become familiar with the
changes. Instructions for installing and running the Prompt10 package are in the PC-
MICAR System Manager’s Manual.

The Spelling Checker

In previous versions of PC-MICAR, terms that did not match the dictionary were brought
to the user's attention for correction. These were done on a causal basis. That is, if the
cause was not found in the dictionary, a warning was given and the user could select from
a list of potential causes. In PC-MICAR 1996, the dictionary match program looks for
errors on a word-by-word basis. That is, each misspelled word in the term is matched
individually, and the list of suggested corrections is a list of properly-spelled words. If all
the words are spelled correctly and the term does not match, this also generates a warning
message.

Reporting Area

The Reporting Area field that appeared on the batch information screen has been removed.
This data is no longer collected.

Coder Status

At the request of several states, the valid values for this field have been expanded to allow
entry of single-digit numbers 0 through 9. 
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Place of Injury

The options for this field have been expanded to accommodate new categories required by
the Tenth Revision of the ICD. To assist in learning and selecting the new codes, a
pop-up menu has been provided, which can be accessed by entering a question mark in
the place of injury field. For a complete list of the places, refer to the 1996 version of the
2g manual or APPENDIX F, pg. 56.

Activity Code

A new field, Activity Code, has been added. This new field collects information about the
decedent's activity at the time of death. A pop-up menu of options is available by entering
a question mark in the field. For a complete list of the activity codes, refer to the 1996
version of the 2g manual.

Backup/Remove Option

This new option backs up the open file to a floppy disk, then, if the backup is successful,
deletes the file from your hard drive.

Backup and MICAR100 Export Paths

In PC-MICAR 1996, it is possible to set up a subdirectory on the computer’s hard drive or
on a network drive in which to store data backups and exported MICAR100 input files.
These options facilitate putting important data on network drives where it can be easily
protected by the local network administrator. These paths should be set by the system
manager. By default, these files are stored in the <DATA> directory.
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OVERVIEW

Basic  Steps

PC-MICAR is designed to allow both data entry and data processing through the menu
system. When collecting and processing data through PC-MICAR, certain steps should be
followed in order to guarantee the best results with the least wasted time. What follows is
a general outline of the MINIMUM data entry and processing steps for PC-MICAR. PC-
MICAR contains several utilities and reports that are helpful in validating data and
keeping track of data entry and processing. Utilities are described in the next section, with
indications of where they would be most useful. 

Note that the relevant sections of this manual are listed next to each step.

1. Start PC-MICAR (Starting PC-MICAR, pg. 13).

2. Open a certificate file (Opening an Existing File, pg. 17). This step opens a file so
that data can be entered and processed. You can either open an existing file or
create a new file. With very few exceptions, every function that PC-MICAR can
perform requires that a file be opened before the function can be preformed.

3. Edit the certificate file header information as needed (Creating a New Certificate
File, pg. 14). The header information contains constant data that is the same for
every record in the certificate file, such as the data year and the state code.

4. Add certificates to the database (ENTERING AND SAVING CERTIFICATE
DATA, pg. 21). This is the main data entry process. PC-MICAR's editing functions
may prove useful in this step (see EDITING FUNCTIONS, pg. 28).

5. Process the certificate file (PROCESSING ALL CERTIFICATES, pg. 36). When a
file is processed, PC-MICAR assigns entity reference numbers (ERNs) to the
medical causes of death that were listed in the certificate file.

6. Generate MICAR100 file (GENERATING A MICAR100 FILE, pg. 38). This file
is used by other MICAR software to continue the process of encoding cause-of-
death data.

7. Create a backup for shipment to NCHS (Creating Backups for NCHS, pg. 40). This
function creates a file that can be shipped to NCHS. The file contains the
MICAR100 file generated in the previous step.
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8. Close the certificate file (CLOSING A FILE, pg. 42).

9. If there are other certificate files to process, repeat steps 2 through 7.

10. If there are no more files to process, exit PC-MICAR and return to DOS
(EXITING PC-MICAR, pg. 47).

Extra  Utilities

Below are listed additional Functions that PC-MICAR can perform. Most of these utilities
can be used at any time with PC-MICAR. Most will require that a certificate file be open.
See the individual description of each utility for more details. Please note that there are
more utilities described in the PC-MICAR System Manager's Manual.

1. Browse through and edit the certificates in a file (Browsing Through the
Certificates, pg. 30). This function allows the user to edit information in the
certificate database, which may be necessary at any time.

2. Find a specific certificate number/record in a file (Finding a Record, pg. 31). This
function is available only when browsing through the certificates and allows the
user to display a particular record by specifying its certificate number.

5. Delete a certificate while editing (Deleting Certificates While Editing a Certificate
File, pg. 34). This function allows the user to remove a record from the certificate
file.

6. Delete several certificates at once (Deleting Several Certificates at Once, pg. 35).
This function allows the user to remove a block of several records from the
certificate file. Use this option if an error has occurred and several certificates have
been entered into the wrong file.

7. Generate a sequence check (Generating a Sequence Check, pg. 43). This function
generates a report that checks the sequence of the certificate numbers in the file. It
is useful in determining if all of the records that should be in the file have been
entered, if unwanted records have been entered, or if records have been entered
with an incorrect certificate number. This function can be used at any time, but is
most useful between data entry and processing to determine if the file is complete.

9. Print all or selected certificates for review. See Printing All the Certificates (pg.
44) and/or Printing a Single Certificate (pg. 45).
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10. Perform a daily backup. (Backing Up All the Files, pg. 39). This function creates a
backup copy of the open certificate file either on your system's hard drive or on a
floppy. Backing up data is the only protection available against losing data due to a
failed computer system. It is a good idea to back up the certificate file at the end
of every day.

There are more Menu Options and Functions available in PC-MICAR than will be used by
data entry personnel. These other Menu Options and Functions will be used by the system
manager. The instructions for them are contained in the PC-MICAR System Manager's
Manual.
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THE MENU SYSTEM

Quick  List  of  Menu  Options

TABLE 1: PC-MICAR Menu Options

Key Combination Menu Option Accessed 

{ALT-F} File Menu Option

{ALT-E} Edit Menu Option

{ALT-P} Process Menu Option

{ALT-R} Reports Menu Option

{ALT-B} Backup Menu Option

{ALT-H} Help Menu Option
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TABLE 2: Function Listing

File
{ALT-F2} Create New File
{F2} Open Existing File
{ALT-F4} Close File

Repair File Index
Merge Another File
Import MICAR100 File

{ALT-F6} Set Data File Path
{SHIFT-F6} Set Table File Path

Set Backup File Path
Set MICAR 100 File Path
DOS Subsession

{ALT-X} Exit PC-MICAR

Edit
Edit/Browse Header Info

{F3} Add Certificates
{F4} Edit/Browse Certificates
{F8} Delete Records
{F5} Find a Record
{F7} Print a Record
{F10} Turn Dictionary On/Off
{ALT-U} Undo Changes

Process
Process All Records
Generate MICAR100 File

Reports
Sequence Check
Print All Certificates

Backup
{ALT-F7} Backup All Files

Backup for NCHS
{ALT-F8} Restore from Backup

Backup and Remove

Help
{F1} View Help File
{ALT-F1} About PC-MICAR
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Using  the  PC-MICAR  Menu  System

PC-MICAR Functions are available through a drop-down menu system. The menu system
allows the user to select Functions to perform and to move from task to task quickly and
easily. Unlike the menu lists available through other types of software, PC-MICAR uses a
menu system that allows an option to be selected from the menu even when another
function is active. This allows users to select functions more quickly, without having to
exit their way 'back up the tree' before they can select another function.

Figure 1: The Edit Menu Option and its Functions.

PC-MICAR 1996: TEST1.DBF
 File Edit Process Reports Backup Help

                                          
  Edit Header Info   
  Add Certificates F3   
  Browse Certificates F4   
  Delete Records F8   
  Find a Record F5   
  Print a Record F7   
  Turn Dictionary On/Off F10   
  Undo Changes ALT-U   
                                          

                       F1-Help 2 58pm

There are two ways to access the menu: 

ALT-X : Simultaneously pressing the {ALT} key and the highlighted letter key of a
main menu item will display the drop-down menu for that item. (The ALT
keys for each menu option are listed in Table 1.) Then use the up and
down arrow keys to highlight an item on the menu. Press {ENTER} to
select the option. Use the left and right arrow keys to open submenus for
other main menu options. Pressing {ESC} from a dropped-down menu
closes the menu. Pressing {ESC} from the main menu will exit PC-
MICAR.

HotKey: Many of the Functions in the menus have an associated hotkey. The hotkey
assignments are shown on the drop-down menus and are listed in Table 2.
Pressing a hotkey will immediately access the associated function. (For
example, pressing {F2} will select the Open Existing File Function.)
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Hotkeys are the fastest, easiest way to move around PC-MICAR. As users
become familiar with PC-MICAR, they will find the hotkeys easier to use. 

To select a Function from a drop-down menu, either use the up and down arrow keys to
highlight an option or press the option's selection letter. The selection letter is displayed in
red (on color monitors) or highlighted (on monochrome monitors). Pressing the selection
letter will move the highlight bar to the selected option.

Figure 1 gives an example of the Edit Menu Option and its Functions.

Not all Functions are available at all times. In order to prevent users from selecting
Functions that should not be accessed during a particular process, the menu system will
make certain Functions available (active) or unavailable (inactive). On color monitors, the
active options are shown in black while inactive options are shown in gray. On
monochrome monitors, inactive options do not have a highlighted selection letter. When
an option is inactive, it cannot be selected (the highlight bar will skip over that item and
its hotkey will not function).
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GETTING STARTED

Starting  PC-MICAR

To start PC-MICAR from DOS, use the following steps:

1. Make sure that DOS is currently in the <PCMICAR> directory.

A. To check to see if the current directory is the <PCMICAR> directory, type CD
and press {ENTER}. The current directory name will appear on the screen.

B. To change the current directory to the <PCMICAR> directory, type CD
\PCMICAR and press {ENTER}.

2. To start PC-MICAR, type PCMICAR and press {ENTER}.

3. The main menu screen (Figure 2) will be displayed. Refer to the section Using the
PC-MICAR Menu System (pg. 11) for more details on the main screen and the
Menu Bar.

When the main screen appears, PC-MICAR is ready to begin. To start work, see Creating

Figure 2: The PC-MICAR Main Screen.

PC-MICAR 1996: TEST1.DBF
 File Edit Process Reports Backup Help

                       F1-Help 2 58pm

a New Certificate File (pg. 14), or Opening an Existing File (pg. 17). PC-MICAR will
"remember" the last file that was opened, so unless the user specifically closes a file (see
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CLOSING A FILE, pg. 42) the last opened file will be open and ready each time PC-
MICAR is started.

About  the  Main  Screen

The main screen of PC-MICAR has several useful features:

1. At the top of the main screen will be the title (PC-MICAR). This line will also
show the file name of any open certificate file (see Opening an Existing File, pg.
17).

2. The second line of the screen holds the menu bar. The menu bar has several words
on it, called Menu Options. Each Menu Option has several Functions that can be
used. See Using the PC-MICAR Menu System (pg. 11) for more details.

3. At the bottom of the screen is a bar displaying some useful information:

A. In the center, a note appears about the {F1} key. The {F1} key will display
PC-MICAR's online Help feature. This will give brief instructions about
whatever part of PC-MICAR is currently being used.

B. In the lower right corner is a clock showing the current time.

Creating  a  New  Certificate  File

There are two ways to open a certificate file for use with PC-MICAR. The first way is by
Creating a New Certificate File (see below). The second way is by Opening an Existing
File (pg. 17). Before data can be entered into a certificate file, a file must be created and
opened. To create a new certificate file, follow these steps:

1. From the main screen, press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Create New File Function and
press {ENTER}.

3. If a file is currently open, a message window will be displayed.

A. To close the currently open file and open a new one, press {Y} and go on to
step 4.
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B. To abort opening a new file and keep using the currently open file, press {N}.
The main screen will be re-displayed. Continue using PC-MICAR normally.

4. A window will be displayed (see Figure 3) requesting a filename. Type in the

Figure 3: A request for a new certificate filename.

PC-MICAR 1996:
 File Edit Process Reports Backup Help

                               
  Specify File Name  
                               
 Enter New File Name:  
   
                               

                       F1-Help 2 58pm

desired 7 character filename WITHOUT the extension and press {ENTER}. If a
file with the entered filename already exists in the <PCMICAR\DATA> directory,
a message window will be displayed. Press {ENTER} and re-enter the filename.

Example: NC96001 {ENTER}

See the PC-MICAR System Manager's Manual for information on suggested file
name conventions. Ask the System Manager for the file name conventions that
should be used.

5. A second window will then be displayed (see Figure 4) asking to confirm the
creation of the new file.

A. To create a new file, type {Y}. The header information screen (step 5) will be
displayed.

B. To abort creation of the new file and return to the main screen, type {N}.

6. When the file is created, the Specify Header Information screen (Figure 5) will be
displayed. The header information will be the same for each record in the file. Fill
in the appropriate header information as follows:
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Shipment - A two-character identifier for the file.

Figure 4: Confirm creation of a new certificate file.

PC-MICAR 1996:
 File Edit Process Reports Backup Help

                                           
  Create new file C:\PCMICAR\DATA\NC93001? 
   
  Yes   No    
                         
                                           

                       F1-Help 2 58pm

Lot # - A number from 000-999. Some states will use "book
number."

Data Year - The last digit for the year of the death certificate (Example:
1991 = 1, 1997 = 7).

State Code - A number identifying the state from which the death
certificate originates. (These states codes are listed in
APPENDIX A, pg. 48). If a two letter abbreviation for a
state is entered, the program will automatically insert the
correct NCHS state code. If the program does not recognize
the abbreviation, it will display an error message and then a
pick list of states. Entering a question mark {?} in this field
will cause a pick list of states to be displayed.

Coder Status - A number from 0-9 used to identify the status of the coder.

Example: Codes for a batch of certificates being processed for data year 1987,
from the State of Alaska, with lot number 303, shipment 02, and coder status 1
would have the following entries: Shipment 02, Lot # 303, Data Year 7, State
Code 02, Coder Status 1.

7. When the coder status has been entered, the header information will be saved and
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the main screen will be re-displayed with the new filename at the top.

Figure 5: The Specify Header Information screen.

                                  
  Specify Header Information  
                                  
   
  Shipment Number:  
   
  Lot Number:  
   
  Data Year:  
   
  State Code:  
   
  Coder Status:  
   
   
           ESC to Exit            

8. To exit the Specify Header Information screen without saving, press {ESC}. The
main screen will be re-displayed.

Opening  an  Existing  File

The steps below tell how to open an existing certificate file for use with PC-MICAR.

1. From the main screen, press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Open Existing File Function and
press {ENTER}.

3. If a file is currently open, a message window will be displayed.

A. To close the currently open file and open a new one, press {Y} and go on to
step 4.

B. To abort opening a new file and keep using the currently open file, press {N}.
The main screen will be re-displayed. Continue using PC-MICAR normally.

4. A file selection window (see Figure 6) will be displayed.
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5. Use the up and down arrow keys to highlight the desired file in the Pick List of

Figure 6: The File Selection Window.

PC-MICAR 1996: TEST1.DBF
 File Edit Process Reports Backup Help

                                                    
  Select file to open  
                                                    
   Directory                                       
  C:\PCMICAR\DATA\    
                                                   
  Files Directories  
  TEST1.DBF   Filter         
  TEST2.DBF  ???????.DBF    
  TEST4.DBF                  
  TEST9.DBF  
    File           
   TEST1.DBF    
                   
   
  Drives OK    
                  
  CANCEL    
                  
                                                    

                       F1-Help 2 58pm

Files. Press {ENTER}.

6. The main screen will be re-displayed with the name of the open file at the top.
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THE DICTIONARY

PC-MICAR comes with an Online Dictionary. The dictionary matches ERNs to user-
entered causes of death. The Dictionary is very syntax specific. This means that for each
term in the Cause, the Dictionary will search for a match. For example, if "ABCESS" (a
misspelling of "ABSCESS") is entered, the Dictionary will not be able to find an exact
match and the first 6 letters ("ABCESS" in our example) will be displayed in the ERN
field.

If all of the words in the cause are spelled correctly, but the specific arrangement of the
term is not in the dictionary, a warning message will be displayed.

If a word is misspelled, the user will be given the opportunity to Accept the word as it is
spelled, Retype the word, or Spellcheck and search for the closest match in the dictionary.

Activating  the  Online  Dictionary

NOTE: The Online Dictionary can only be accessed when adding or editing certificates
(see Adding Certificates, pg. 21, and EDITING FUNCTIONS, pg. 28).

Use the instructions below if the Online Dictionary is turned off (the words "Dictionary
OFF" appear at the bottom of the certificate information screen).

1. Press {ALT-E} to access the Edit Menu Option.

2. Use the up and down arrows to highlight the Dictionary ON/OFF Function. Press
{ENTER}.

3. IMPORTANT: To indicate that the Online Dictionary is active, "Dictionary On"
will be displayed on the bottom line of the certificate information screen. If the
dictionary is turned off, "Dictionary Off" will be displayed on the bottom liner of
the same screen.

Deactivating  the  Online  Dictionary

NOTE: The Online Dictionary can only be accessed when adding or editing certificates
(see Adding Certificates, pg. 21, and EDITING FUNCTIONS, pg. 28).
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Use the instructions below if the Online Dictionary is turned on ("Dictionary On" is
displayed at the bottom of the certificate information screen) and needs to be turned off.

1. Press {ALT-E} to access the Edit Menu Option.

2. Use the up and down arrows to highlight the Online Dictionary. Press {ENTER}.

3. The Online Dictionary is now turned off. "Dictionary Off" will be displayed in the
bottom line of the certificate information screen.

NOTE: The {F-10} Hot Key can be used at any time to toggle dictionary on or off.
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ENTERING AND SAVING CERTIFICATE DATA

There are several Functions that can be used to enter and save data in PC-MICAR. It is
recommended that a sequence check (see Generating a Sequence Check, pg. 43) be
performed after all of the certificate data has been entered.

Adding  Certificates

In order to add certificates, the following actions must have already been performed:

Opening a file (Creating a New Certificate File pg. 14, or Opening an Existing File pg.
17).

Adding certificates to a file is the primary data entry function. Use the instructions below
to add certificates to an open file.

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Add Certificates Function and
press {ENTER}.

3. A message window will be displayed showing how many certificates may be
entered on the computer. This is determined by the amount of free space on the
hard drive. Press {ENTER}.

4. The Certificate Information Screen (see Figure 7) will be displayed.

5.  Table 3 lists the special keys and their functions for adding certificates.

Table 3: Function Keys For Adding Certificates

{ALT-F9} Saves the current certificate and exits the editing screen.

{ALT-U} Undo the last command. See Undoing Changes, pg. 32.

{CTRL-ENTER} Saves the certificate information on disk and advances
to the next certificate.

{ESC} Exits this menu Function and returns to the
CERTIFICATE EDITING submenu.
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Table 3: Function Keys For Adding Certificates

{SHIFT-TAB} Moves the cursor to the previous field.

{TAB} Moves the cursor to the next field.

6. Enter the following certificate information in the corresponding fields on the
screen. NCHS rules on special cases that affect the data entered have been
provided as notes after each field description. Remember, the {TAB} and {SHIFT-
TAB} keys can be used to move from field to field.

Certificate # The certificate number. This can usually be found in the upper
right hand corner of the standard U. S. Certificate of Death.

Sex The sex of the decedent. 1 - Male, 2 - Female, or 9 -
Unknown. Letters (M, F, or U) will be converted to their
corresponding numbers.

Date of Death The date of the decedent's death as reported on the death
certificate. Give it in the following format: MM/DD (where
MM = the month (01-12, 99) and DD = the day of the month
(01-31, 99)). PC-MICAR will keep track of the year using the
header information (see Editing Header Information, pg. 28).
Dates after the current (today's) date will not be accepted.

Age The decedent's age at the time of death. (For the code structure,
refer to the Part 2g VSIM manual.) Values that will be accepted
are: 001-699 and 901-999.

State Users cannot enter data in this field. The state is entered in the
header information (see Editing Header Information, pg. 28).

P# Part Number. Indicates whether the data entered on this line
comes from Part I or Part II of the death certificate. Acceptable
values are 1 (which is what will appear in the field unless the
user changes this), 2, and 0. Entering a zero {0} in this field
will skip the remaining causes and move the cursor to the
Manner of Death Field.

L# Line number. Corresponds to the lines in Part I on the
certificate (A, B, C, D), or the lines in Part II (01, 02, 03, etc).
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Values can range from A-I for Part I and 1-20 for Part II. All
line numbers must be sequential.

Figure 7: The Certificate Information Screen.

PC-MICAR 1996: TEST1.DBF
  File     Edit     Process     Reports     Backup        Help

Certificate: 000014 Sex: Date of Death: Age: State: 

P#L# C# ERN CAUSE Dur

Manner: Injury Date: At Work?: Injury Place:

P#L# C# ERN CAUSE Dur

Date of Surgery: State-Specific Data:

C# Cause number. This is a number generated by PC-MICAR. It
cannot be changed during data entry. If more than one item was
entered on a line on the death certificate, this number indicates
which cause number (from the certificate line) is being entered.

ERN The Entity Reference Number. If the Dictionary is OFF (see
THE DICTIONARY, pg. 19), the first six letters of the CAUSE
field will be placed here. If the Dictionary is ON, an ERN will
be supplied by PC-MICAR (if no ERN match is found, the first
6 letters of the term will be used instead). This field cannot be
changed during data entry.
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Cause The cause of death listed on the certificate. These must be in
standard MICAR nomenclature or an entity reference number
(ERN). To access the external cause prompts, enter a '>' here
(see Entering External Cause Prompts, pg. 27).

Dur Duration. The duration of the listed condition. (For the code
structure, refer to the Part 2g manual.)

Manner Manner of Death listed on the certificate. Entering an asterisk
(*) in the Manner of Death will immediately move the cursor to
the Surgery Date field. This will leave Manner of Death blank.
If a question mark (?) is entered, a pick list of valid Manner of
Death codes will appear:

1: Accident
2: Suicide
3: Homicide
4: Deferred
4: Pending Investigation
4: Unclassified
5: Undetermined
6: Self-Inflicted
7: Natural
Not Specified

Injury Date The date of any injury as listed on the certificate. This date
cannot be after the date of death and will appear as
MM/DD/YY, where MM is the two digit month, DD is the two
digit day, and YY is the last two digits of the year.

At Work? Did the injury occur at work? Enter a "1" for YES or leave
blank for NO.

Injury Place Location at which the injury occurred. See APPENDIX F (pg.
56) for a list of valid place of injury codes.

Activity Code Activity the decedent was undertaking when death occurred.
Entering a question mark (?) will cause the following pick list
to appear:

Page 24 Data Processing Manual



National Center for Health Statistics PC- MICAR

0: While Engaged in Sports Activity
1: While Engaged in Leisure Activity
2: While Working for Income
3: While Engaged in Other Types of Work
4: While Resting, Sleeping, Eating (Vital Activities)
8: While Engaged in Other Specified Activities
9: During Unspecified Activity
Blank

Injury Causes This is the second set of lines (P#, L#, C#, Injury cause
line) in the bottom quarter of the screen. The columns hold
the same information as those described above. The
information entered here is reported in the injury description
block on the death certificate.

Entering a ‘0' in the P# will move the cursor to Date of
Surgery.

Injury Date A field that holds the month/day/year of the injury.

State-Specific Info State offices can enter state-specific information in this
field.

7. Following is a list of symbols, and their meanings, that are commonly used on the
Cause of Death sections of a death certificate. This list is also included in
APPENDIX E - SPECIAL SYMBOLS (pg. 55) at the end of this manual.

# "Fracture." Substitute for the word "fracture." Example: For "Leg #,"
type "LEG FRACTURE".

↓ "Decreased." Substitute for the word "decreased." Example: For "↓
blood pressure," type "DECREASED BLOOD PRESSURE".

↑ "Increased." Substitute for the word "increased." Example: For "↑
hemorrhaging," type "INCREASED HEMORRHAGING".

o   oI "Hour." Substitute for the word "Hour." Example: For "1 I," type "1
HOUR".
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1° "Primary." Substitute for the word "primary." Example: For "1° colon
cancer," type "PRIMARY COLON CANCER".

2° "Secondary to." Substitute for the words "secondary to." Example: For
"Pneumonia 2° cardiorespiratory infection," type "PNEUMONIA
SECONDARY TO CARDIORESPIRATORY INFECTION".

c
_

"With." Substitute for the word "with." Example: For "Heat stroke c
_

myocardial infarction," type "HEAT STROKE WITH MYOCARDIAL
INFARCTION".

p
_

"After." Substitute for the word "after." Example: For "Spontaneous
bleeding p

_
 tracheal tube removal," type "SPONTANEOUS BLEEDING

AFTER TRACHEAL TUBE REMOVAL".

s
_

"Without." Substitute for the word "without." Example: For "Went three
weeks s

_
 taking medication," type "WENT THREE WEEKS WITHOUT

TAKING MEDICATION".

w/ "With." Substitute for the word "with." Example: For "Heat stroke w/
myocardial infarction," type "HEAT STROKE WITH MYOCARDIAL
INFARCTION".

8. When the end of the last field has been reached, press {ENTER} or {PgDown}.
The certificate will be saved and a blank screen for a new record will be displayed.

9. The Enter Certificate Information screen will be re-displayed with all but one of
the fields blank (the certificate number field will contain data). A new certificate
number will be automatically generated by the program. (The user can change this
certificate number if desired.) Go to step 5 above to enter another certificate.

10. To exit the Add Certificate Function, press the {ESC} key when a new certificate
screen is displayed. NOTE: Pressing {ESC} from a screen that contains data WILL
NOT save that data. Press {ALT-F9} to save the current certificate and exit the
Add Certificates function.

11. The main screen will be redisplayed.
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Entering  External  Cause  Prompts

Entering a greater-than sign (>) in any of the Cause fields on the Certificate Information
Screen will cause a series of menus containing the external cause prompts to be displayed.
To enter an external cause, simply type in the one to two letter/number code next to the
external cause. Repeat this process as each new menu appears. When the complete
external cause code has been entered, the Certificate Information Screen will be re-
displayed with the external cause code in the Cause field.

PC-MICAR uses the ICD9/ICD10 Universal Prompts for collecting external causes. These
new prompts are significantly changed from previous years. The practice exercise included
with the installation disks will help coders become familiar with the changes.
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EDITING FUNCTIONS

PC-MICAR has several Functions that can be used to edit a certificate file and the data it
contains. The most commonly used Function for this will be the Edit/Browse Certificate
Function (see Browsing Through the Certificates on pg. 30). Other Functions that will be
used to edit certificate data are: the Edit/Browse Header Information Function and the
Find a Record Function. The Exit PC-MICAR, Delete Records, and Show Processed
Output can also be used and are described in other parts of this manual.

Editing  Header  Information

Before header information can be edited, the following actions must have already been
performed:

Opening a file (Creating a New Certificate File pg. 14, or Opening an Existing File pg.
17).

The steps below are used to edit the certificate file's header information. This Function
can be used only when a certificate file is open.

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Edit/Browse Header Info
Function and press {ENTER}.

3. The Specify Header Information screen (Figure 8) will be displayed. Fill in the
appropriate header information as follows:

Shipment - A two-character identifier for the file.

Lot # - A number from 000-999. Some states will use "book
number."

Data Year - The last digit for the year of the death certificate (Example:
1991 = 1, 1997 = 7).

State Code - A number identifying the state from which the death
certificate originates. (These states codes are listed in
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APPENDIX A - NCHS STATE CODES, pg. 48). If a two
letter abbreviation for a state is entered, the program will
automatically insert the correct NCHS state code. If the
program does not recognize the abbreviation, it will display
an error message and then a pick list of states. Entering a
question mark {?} in this field will cause a pick list of
states to be displayed.

Coder Status - A number from 0-9 used to identify the status of the
Figure 8: The Specify Header Information screen.

                                  
  Specify Header Information  
                                  
   
  Shipment Number:  
   
  Lot Number:  
   
  Data Year:  
   
  State Code:  
   
  Coder Status:  
   
   
           ESC to Exit            

coder.

Example: Codes for a batch of certificates being processed for data year 1987,
from the State of Alaska, with lot number 303, shipment 02, and coder status 1
would have the following entries: Shipment 02, Lot # 303, Data Year 7, State
Code 02, Coder Status 1.

4. To save the header information, press {CTRL-ENTER}. The main screen will be
re-displayed.

5. To exit the Specify Header Information screen without saving, press {ESC}. The
main screen will be re-displayed.
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Browsing  Through  the  Certificates

Before the browse Function can be used, the following actions must have already been
performed:

Opening a file (Creating a New Certificate File pg. 14, or Opening an Existing File pg.
17).

This Function allows the user to manually browse through a certificate file. Other Edit
Functions can be used with the Edit/Browse Function.

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Edit/Browse Certificates Function
and press {ENTER}.

3. The Certificate Information Screen (see Figure 7) will be displayed. Descriptions of
this screen and its fields can be found in the section Adding Certificates (pg. 21)
earlier in this manual.

4. The {PgUp} and {PgDn} keys will cause the preceding or next certificate to be
displayed.

5. Any of the following Functions may be used while in Edit/Browse:

File - Exit PC-MICAR.
Edit - Delete Records, Find a Record, Print a Record, Turn Dictionary

On/Off, Undo Changes.
Help - Help, About

6. To edit the data for a certificate, simply type in the changes in the appropriate
field. Editing keys are listed in Table 6.

7. When all of the changes have been made, save the certificate data by pressing
{CTRL-ENTER}.

8. When finished viewing the certificates, press the {ESC} key. The main screen will
be re-displayed.
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Table 6: Function Keys For Editing Certificates

{F5} Find a specific certificate. See Finding a Record, pg.
31.

{F7} Print Current Certificate. Prints the currently displayed
certificate on the printer.

{F8} Deletes the currently displayed certificate from the
database.

{ALT-1} Displays causes 1-10.

{ALT-2} Displays causes 11-20.

{ALT-F9} Saves the currently displayed certificate and exits the
editing screen.

{ALT-U} Undo changes to the certificate. See Undoing Changes,
pg. 32.

{CTRL-ENTER} Saves the certificate information on disk.

{ESC} Ends editing and returns to the main screen.

{SHIFT-TAB} Moves the cursor to the previous field.

{TAB} Moves the cursor to the next field.

Finding  a  Record

Before the Find a Record Function can be used, the following actions must have already
been performed:

Opening a file (Creating a New Certificate File pg. 14, or Opening an Existing File pg.
17).

The file must have certificates in it to be searched.

The Find a Record Function allows the user to find a particular certificate quickly. This is
especially useful when editing certificate data.
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1. While the Certificate Information screen is displayed (by using the Edit/Browse
Certificates Function), press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Find a Record Function. Press
{ENTER}.

3. A window (see Figure 9) will be displayed.

4. Type in the certificate number of the desired certificate and press {ENTER}.

A. If the certificate number is in the currently open file, that certificate's data will
be displayed.

B. If the certificate number is not in the currently open file, a message will be
displayed. Press {ENTER}.

5. The Certificate Information Screen will be re-displayed.

Figure 9: Enter the number to find.

                                              
  Certificate Number Search  
                                              
   
  Find the certificate number:  
   
                                              

Undoing  Changes

Sometimes a change will mistakenly be made to a certificate. These changes can be
undone if the certificate has not been saved yet. (This means that the user hasn't pressed
{CTRL-ENTER}. The Undo Changes Function in the Edit submenu will replace the
displayed certificate with the original data from the certificate file.

1. While the Certificate Information screen is displayed (by using the Edit/Browse
Certificates Function), press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Undo Changes Function. Press
{ENTER}.
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3. The Certificate Information Screen will be re-displayed with the most recently
saved data.
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DELETING RECORDS

PC-MICAR also offers the ability to delete certificates, either individually or in groups,
from the database. A word of warning: Once a certificate is deleted, IT IS GONE from
PC-MICAR's database. The only way to recover deleted certificates is to restore from an
existing backup of the file. This assumes that a backup exists. See the section Creating
Backups For NCHS (pg. 40) or any of the backup routines in the PC-MICAR System
Manager's Manual for information on backing up and restoring files.

Given below are two ways to delete certificates from PC-MICAR's database. The first
method deletes one certificate at a time. The second can delete any number of certificates
in a database file, up to the highest certificate number entered. Note that {F8} can be used
in conjunction with the Edit/Browse Function (see Browsing Through the Certificates, pg.
30).

Deleting  Certificates  While  Editing  a  Certificate  File

The steps below can be used when the Certificate Information Screen (see Figure 7) is
displayed. The steps below allow the user to delete the currently displayed certificate from
the certificate file.

1. Access the Certificate Information Screen for the desired certificate. The
instructions for doing this can be found in the Browsing Through the Certificates
(pg. 30) section of this manual.

2. Press {ALT-E} to select the Edit Menu Option.

3. Use the up and down arrow keys to highlight the Delete Records Function. Press
{ENTER}.

4. A window will be displayed asking to confirm deleting the displayed certificate
data.

A. To delete the certificate from the certificate file, press {Y}. The next certificate
in the file will then be displayed.

B. To abort the deletion, press {N}. The certificate will be re-displayed.

5. The Certificate Information Screen (Figure 7) will be displayed.
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Deleting  Several  Certificates  at  Once

If the Delete Records Function is used when the Certificate Information screen (see Figure
7) is not displayed, the user can delete a group of certificates at once. Note that this is a
sequential deletion - the certificates to be deleted must appear one after another.

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Delete Records Function. Press
{ENTER}.

3. A window will be displayed requesting a range of certificate numbers to delete.

4. Type in the certificate number of the first certificate to be deleted (Beginning
Certificate Number). Then use the {TAB} key to move the cursor to the Ending
Certificate Number.

5. Type in the certificate number of the last (ending) certificate to be deleted and
press {ENTER}. If the beginning and ending certificate numbers are the same, only
that one certificate will be deleted.

6. Another message will be displayed requesting confirmation to delete the specified
records.

A. To delete the records, type {Y}. A progress bar (Figure 10) will be displayed
showing what percentage of the certificates have been deleted.

B. To abort the deletion, type {N}.

8. A third message will be displayed asking if the user wishes to delete more records.

A. To delete another group of certificates, type {Y} and repeat the steps above.

B. To exit and re-display the main screen, type {N}.
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PROCESSING ALL CERTIFICATES

Before records can be processed, the following actions must have already been performed:

NOTE: If the dictionary is on, processing is not required since the dictionary will assign
ERNs as data is entered. These terms are considered to have already been processed and
will not be re-processed when this function is used. It is still recommended that the
certificate file be processed, since the dictionary may have been turned off during data
entry.

Opening a file (Creating a New Certificate File pg. 14, or Opening an Existing File pg.
17).

Please note that the file must have certificates in it to process.

Processing is the method PC-MICAR uses to convert the cause of death information into
NCHS's Entity Reference Numbers (ERN), and is equivalent to the batch process used in
previous versions of PC-MICAR to match terms to the dictionary. The Process All
Records Function can process approximately 10,000 certificates per hour on an average
computer. The user does not need to do anything while the processing is occurring.

1. From the main screen, press {ALT-P} to select the Process Menu Option.

2. Use the up and down arrow keys to highlight the Process All Records Function and
press {ENTER}.

3. A message window will be displayed saying that the tables are being loaded.

4. When the tables are loaded, a progress bar (see Figure 10) will be displayed on the
screen showing what percentage of the data file has been processed.

5. The certificate number for the certificate currently being processed is displayed in
the lower left corner of the screen.

6. Occasionally, PC-MICAR will take a long time to process a certificate. In these
cases, the word "Thinking" will be displayed in the lower left corner of the screen,
beside the certificate number. A 'spinning wheel' beside the word indicates that PC-
MICAR is still processing the record.

7. No other activity is needed during processing.
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8. When the processing is complete, a Processing Results report will be displayed.

Figure 10: A bar graph showing the progress of file processing.

                                                             
  Processing File C:\PCMICAR\DATA\TEST1.DBF (ESC Exits)  
                                                             
  46%  
                                                             
  0 Estimated time remaining: 00:00:00 100  
                                                             

NOTE: Terms entered while the dictionary is turned on are considered to have
already been processed and will not be displayed in this report. See the note box at
the beginning of this section for more details.

A. To print out a copy of the report and a list of dictionary matching errors, press
{Y}.

B. To abort the printing and return to the main screen, press {N}.

The Processing Results report and error listing report are saved to your <DATA> directory,
whether or not you print it. It is named filename.MER.
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GENERATING A MICAR100 FILE

Before generating a MICAR100 file, the following actions must have already been
performed:

Opening a file (Creating a New Certificate File pg. 14, or Opening an Existing File pg.
17).

Please note that the file must have certificates in it to process.

The file must have been processed already (PROCESSING A CERTIFICATE FILE, pg.
36), or matched to the dictionary during data entry. 

If the certificate data entered in the data file is going to be transferred to a local
mainframe for further processing, a MICAR100 file will need to be generated. The
MICAR100 file contains all of the processed entity reference numbers and their
identifying information. This file can be used as input to mainframe MICAR100, the next
application in the MICAR process. This file is equivalent to the .MF file produced in
previous versions of PC-MICAR. If the data is to be processed through PC-MICAR100
and 200 software, this step is unnecessary. To generate the MICAR100 file, follow these
steps.

1. From the main screen, press {ALT-P} to select the Processing Menu Option.

2. Use the up and down arrow keys to highlight the Generate MICAR100 File
Function. Press {ENTER}.

3. A progress bar (Figure 10) will be displayed showing what percentage of the
certificates have been exported to a MICAR100 file.

4. When the MICAR100 file is complete, the main screen will be re-displayed.

The MICAR100 input file is created in the <DATA> directory. It is named filename.1IN.
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CREATING BACKUPS

The Backup and Remove, and the Restore from Backup Functions are detailed in the PC-
MICAR System Manager's Manual.

Backing  Up  All  the  Files

Before backups can be created, the following actions must have already been performed:

Opening a file (Creating a New Certificate File pg. 14, or Opening an Existing File pg.
17).

Please note that the file must have certificates in it in order to create the backup.

It is strongly recommended that a backup of all the files be made at the end of the day.
This will help prevent data loss from corrupted files or other problems. The Backup All
Files Function creates a single backup file, called [filename].PBK, that contains all of the
files associated with a batch of certificates. To make a backup of all the files, do the
following:

1. From the main screen, press {ALT-B} to select the Backup Menu Option.

2. Use the up and down arrow keys to highlight the Backup All Files Function. Press
{ENTER}.

3. A window (see Figure 11) will be displayed requesting a drive to put the backup

Figure 11: Choose a drive to put the backup file on.

                            
  Select Drive for Backup  
                            
  Backup Directory  
  Floppy Drive A  
  Floppy Drive B  
                            

file on.

A. To put the backup in the <BACKUP> directory on the computer’s hard drive,
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use the {TAB} key to highlight Backup Directory and press {ENTER}.

B. To put the backup on floppy drive A, put a disk in drive A and use the {TAB}
key to highlight Floppy Drive A. Press {ENTER}.

C. To put the backup on floppy drive B, put a disk in drive B and use the {TAB}
key to highlight Floppy Drive B. Press {ENTER}.

4. After a valid drive has been selected, a message window will be displayed while
the backup is being made.

5. When the backup is complete, the main screen will be re-displayed.

Creating  Backups  for  NCHS

Before backups can be created, the following actions must have already been performed:

Opening a file (Creating a New Certificate File pg. 14, or Opening an Existing File pg.
17).

Please note that the file must have certificates in it in order to create the backup.

After all editing and processing has been finished, backups of the certificate data should
be made. The backups should be sent to NCHS for further processing. This Function will
create a ssyylll.PCM file (ss = state code, yy = year, lll = lot number) containing a
MICAR100 file.

1. From the main screen, press {ALT-B} to select the Backup Menu Option.

2. Use the up and down arrow keys to highlight the Backup for NCHS Function.
Press {ENTER}.

3. A window (see Figure 11) will be displayed requesting a drive to put the backup
file on.

A. To put the backup in the <BACKUP> directory on the computer’s hard drive,
use the {TAB} key to highlight Backup Directory and press {ENTER}.

B. To put the backup on floppy drive A, put a disk in drive A and use the {TAB}
key to highlight Floppy Drive A. Press {ENTER}.
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C. To put the backup on floppy drive B, put a disk in drive B and use the {TAB}
key to highlight Floppy Drive B. Press {ENTER}.

4. After a valid drive has been selected, a message window will be displayed while
the backup is being made.

5. When the backup is complete, the main screen will be re-displayed.
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CLOSING A FILE

A certificate file will normally be closed when the user is ready to start on a new batch of
certificates (which involves creating a new certificate file, as described in Creating a New
Certificate File, pg. 14). At other times, PC-MICAR will require that the certificate file be
closed to perform some of the menu functions. In any case, closing a PC-MICAR file is
very easy:

1. From the main screen, press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Close File Function and press
{ENTER}.

3. The currently open file will be closed. The filename will disappear from the top of
the screen. PC-MICAR is now ready to open another file for processing.
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GENERATING REPORTS

The Functions given below can be used to generate PC-MICAR Reports. The Sequence
Check tells the user if there are any missing certificate numbers.

Generating  a  Sequence  Check

The Sequence Check Function creates a file (named filename.SSQ) containing a report on
missing, extra, duplicate, and out of sequence certificates by certificate number in the
database file. The Sequence Check can be used only when a file is currently open. To use
the sequence check, do the following:

1. From the main screen, press {ALT-R} to select the Reports Menu Option.

2. Use the up and down arrow keys to highlight the Sequence Check Function. Press
{ENTER}.

3. A window will be displayed requesting a beginning certificate number and an
ending certificate number (see Figure 12). Normally, PC-MICAR will have already
filled in the appropriate numbers. If these need to be changed, or the fields are
empty, do the following:

A. Use the {TAB} key to place the cursor in the desired field.

B. Type in either the beginning certificate number (the starting certificate number
for the sequence check) or the ending certificate number (the ending certificate
number for the sequence check), and press <ENTER>.

4. A progress bar (see Figure 10) will be displayed showing the progress of the
sequence check.

5. When the sequence check is completed, a message window will be displayed. Press
any key to continue.

6. The output of the sequence check (filename.SSQ) will then be displayed. Use the
up and down arrow keys to scroll through the output (or {PgUp} and {PgDn}).
Press the {ESC} key to close the output window.

7. Next, the computer will beep and a print request window (see Figure 13) will
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appear.

Figure 12: The Sequence Check screen.

                                                    
  Enter Beginning and Ending Numbers  
                                                    
   
   
  Beginning Certificate Number: 000002  
   
  Ending Certificate Number: 099999  
   
   
   
   
                Press ESC to Cancel                 

A. To print out a copy of the sequence check report, type {Y}. A printing in

Figure 13: A Print Request window.

                                        
   
  Do you want to print the report?  
   
  Yes   No    
                       
                                        

progress window will appear. When the printing is finished, the main screen
will be re-displayed.

B. To abort the printing and re-display the main screen, type {N}.

Printing  All  the  Certificates

PC-MICAR allows the user to print out all of the certificates within a file. These hardcopy
printouts can be used to check for errors as well as any other purposes determined by the
Supervisor.
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1. From the main screen, press {ALT-R} to select the Reports Menu Option.

2. Use the up and down arrow keys to highlight the Print All Certificates Function
and press {ENTER}.

3. A window will be displayed saying, “Pring Certificate(s)?”.

A.  To print the certificates, press {Y}.

B. To abort the printing and return to the main screen, press {N}.

4. A message window will be displayed saying, "Printing in progress. Please wait." 
The certificates will be printed.

5. When printing is finished, the main screen will be re-displayed.

Printing  a  Single  Certificate

PC-MICAR also allows single certificates to be printed. The process for doing this is
described below:

1. From the main screen, press {ALT-E} to select the Edit Menu Option.

2. Use the up and down arrow keys to highlight the Edit/Browse Certificates Function
and press {ENTER}.

3. A Certificate Information Screen (see Figure 7) will be displayed. Use the
instructions under Finding a Record (pg. 31) to find the specific certificate to print
out.

4. With the desired certificate displayed, press {ALT-E} to select the Edit Menu
Option. Alternatively, press {F7} and go directly to step 6.

5. Use the up and down arrow keys to highlight the Print a Record Function and
press {ENTER}.

6. A window will be displayed saying, “Pring Certificate(s)?”.

A.  To print the certificates, press {Y}.
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B. To abort the printing and return to the main screen, press {N}.

7. A message window will be displayed saying, "Printing in progress. Please wait." 
The certificates will be printed.

8. When printing is finished, the main screen will be re-displayed.
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EXITING PC-MICAR

There are two ways to exit PC-MICAR. The first, and easiest, is by pressing {CTRL-X}
and following step 3 below. The second method is also described below.

1. From the main screen, press {ALT-F} to select the File Menu Option.

2. Use the up and down arrow keys to highlight the Exit PC-MICAR Function and
press {ENTER}.

3. A message window will be displayed.

A. To exit PC-MICAR, press {Y}. PC-MICAR will end and the DOS prompt will
be displayed.

B. To abort the exit, press {N}. The main screen will be re-displayed.
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APPENDIX A - NCHS STATE CODES

Code State Abbrev.
01 Alabama AL
02 Alaska AK
03 Arizona AZ
04 Arkansas AR
05 California CA
06 Colorado CO
07 Connecticut CT
08 Delaware DE
09 Dist. Columbia DC
10 Florida FL
11 Georgia GA
12 Hawaii HI
13 Idaho ID
14 Illinois IL
15 Indiana IN
16 Iowa IA
17 Kansas KS
18 Kentucky KY
19 Louisiana LA
20 Maine ME
21 Maryland MD
22 Massachusetts MA
23 Michigan MI
24 Minnesota MN
25 Mississippi MS
26 Missouri MO
27 Montana MT

Code State Abbrev.
28 Nebraska NE
29 Nevada NV
30 New Hampshire NH
31 New Jersey NJ
32 New Mexico NM
33 New York NY
34 North Carolina NC
35 North Dakota ND
36 Ohio OH
37 Oklahoma OK
38 Oregon OR
39 Pennsylvania PA
40 Rhode Island RI
41 South Carolina SC
42 South Dakota SD
43 Tennessee TN
44 Texas TX
45 Utah UT
46 Vermont VT
47 Virginia VA
48 Washington WA
49 West Virginia WV
50 Wisconsin WI
51 Wyoming WY
52 Puerto Rico PR
53 Virgin Islands VI
54 Guam GU
55 New York City YC*

* Code 55 is used for occurrence data only. When coding residence data on the demographic
file, code 33 (New York State) must be used.
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APPENDIX B - MENU LISTINGS

PC-MICAR Menu Options

Key Combination Menu Option Accessed 

{ALT-F} File Menu Option

{ALT-E} Edit Menu Option

{ALT-P} Process Menu Option

{ALT-R} Reports Menu Option

{ALT-B} Backup Menu Option

{ALT-H} Help Menu Option
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Function Listing

File
{ALT-F2} Create New File
{F2} Open Existing File
{ALT-F4} Close File

Repair File Index
Merge Another File
Import MICAR100 File

{ALT-F6} Set Data File Path
{SHIFT-F6} Set Table File Path

Set Backup Path
Set MICAR 100 Path
DOS Prompt

{ALT-X} Exit PC-MICAR

Edit
Edit/Browse Header Info

{F3} Add Certificates
{F4} Edit/Browse Certificates
{F8} Delete Records
{F5} Find a Record
{F7} Print a Record
{F10} Turn Dictionary On/Off
{ALT-U} Undo Changes

Process
Process All Records
Generate MICAR100 File

Reports
Sequence Check
Print All Certificates

Backup
{ALT-F7} Backup All Files

Backup for NCHS
{ALT-F8} Restore from Backup

Backup and Remove
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Help
{F1} View Help File
{ALT-F1} About PC-MICAR
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APPENDIX C - DICTIONARY OF TERMS USED

Since not everyone will be familiar with the terms used in these instructions, here is a
brief glossary of some of the words.

Certificate File - A file containing certificate data. This term is used interchangeably
with Database File.

Data Directory - A subdirectory on the computer where PC-MICAR certificate files
are stored. By default, the data directory is a subdirectory of the
<PCMICAR> directory called <DATA>. The default value can be
changed through PC-MICAR.

Database File - A file containing certificate data. This term is used interchangeably
with Certificate File.

Directory - A specific grouping of files on a disk. Also referred to as a
subdirectory. The directory that will be used most with PC-MICAR
will be the <PCMICAR> directory.

DOS - A Disk Operating System. The System Manager will handle most
operations that deal with DOS. The only time the data entry
personnel will use DOS will be in the STARTING PC-MICAR
section of this manual.

Export - To take data from the PC-MICAR certificate database and place it
in a formatted file that is readable by other programs.

Extension - A 3-letter identifier at the end of a filename that identifies what
type of file it is. For example: .EXE is an executable file, .DBF is a
database file, and so forth.

Filename - The name of a file on a disk. Example: PCMICAR.EXE is made up
of the filename PCMICAR and extension .EXE.

Hotkey - A key or pair of keys that can be pressed to access a menu function
directly, without going through the menu system. For example,
pressing the F2 key will access the Open a File menu option.

Import - To read data from a formatted file and place it in a PC-MICAR
certificate database. 
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Menu - A list from which an action can be selected for PC-MICAR to
perform. PC-MICAR has both a main menu and submenus. The
main menu appears as a bar across the top of the screen, just below
the program name. From the main menu, a submenu can be
displayed listing actions to be performed. See the section Using the
PC-MICAR Menu System (pg. 11) for more details on how to use
the menu.

Pick List - A list of items that can be selected (picked) by using the up and
down arrow keys to highlight the desired item and then pressing
{ENTER}.

Subdirectory - See Directory above.

Submenu - A group of related actions arranged into a list from which an action
can be selected. Submenus are available through the main menu.
See the section Using the PC-MICAR Menu System (pg. 11) for
more information on the menu system.

Table - A subdirectory on the computer where PC-MICAR processing
Directory files are stored. By default, the table directory is a subdirectory of

the <PCMICAR> directory called <TABLES>. The default value
can be changed through PC-MICAR.
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APPENDIX D - CONVENTIONS USED IN THIS MANUAL

As a rule, any commands that need to be entered while the user is in PC-MICAR will be
given in the following format:

1. All of the actual typing and keys that need to be pressed will be given in all-caps
(Example: type DIR and press {ENTER} to get a list of files in a directory).

2. Any information that the user needs to provide, such as filenames, will be
requested in brackets (Example: type [filename.ext] means that the user needs to
type in the filename and its extension, like so: type WY91001.DBF, without the
brackets.)

3. When the word "press" appears in front of a word in all-caps, the user needs to
press and release a particular key (Example: press {ESC} means press and release
the ESC key). Also, the names of all keys will be given in braces {}.

4. Whenever two keys are named with a hyphen ( - ) connecting them, both keys are
to be pressed at the same time to perform the listed function (Example:
{CTRL-ENTER} = press and hold the {CTRL} and {ENTER} keys at the same
time).

5. At times, references will be made to other Menu Options or Functions of
PC-MICAR. The following standards will be used in these cases:

A. Any selection from the Main Menu (the menu that runs across the top of the
PC-MICAR screen, just below the title) will be called a Menu Option
(Example: the File Menu Option).

B. Any selection from a submenu will be called a menu Function or just Function
(Example: the Edit/Browse Certificates Function).

6. All directory names will be marked by greater than and less than symbols
(Example: The directory containing the PC-MICAR programs is the <PCMICAR>
directory).
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APPENDIX E - SPECIAL SYMBOLS

Following is a list of symbols and their meanings commonly used on the Cause of Death
sections of a death certificate. This list is for use with Adding Certificates, pg. 21.

# "Fracture." Substitute for the word "fracture." Example: For "Leg #," type "LEG
FRACTURE".

↓ "Decreased." Substitute for the word "decreased." Example: For "↓ blood pressure,"
type "DECREASED BLOOD PRESSURE".

↑ "Increased." Substitute for the word "increased." Example: For "↑ hemorrhaging,"
type "INCREASED HEMORRHAGING".

o
I "Hour." Substitute for the word "Hour." Example: For "1 o/I," type "1 HOUR".

oo
II "Secondary to." Substitute for the words "secondary to." Example: For "Pneumonia

00/II Gunshot wound," type "PNEUMONIA SECONDARY TO GUNSHOT
WOUND".

1° "Primary." Substitute for the word "primary." Example: For "1° colon cancer," type
"PRIMARY COLON CANCER".

2° "Secondary to." Substitute for the words "secondary to." Example: For "Pneumonia
2° cardiorespiratory infection," type "PNEUMONIA SECONDARY TO
CARDIORESPIRATORY INFECTION".

c
_

"With." Substitute for the word "with." Example: For "Heat stroke c
_

 myocardial
infarction," type "HEAT STROKE WITH MYOCARDIAL INFARCTION".

p
_

"After." Substitute for the word "after." Example: For "Spontaneous bleeding p
_

tracheal tube removal," type "SPONTANEOUS BLEEDING AFTER TRACHEAL
TUBE REMOVAL".

s
_

"Without." Substitute for the word "without." Example: For "Three weeks s
_

 taking
medication," type "THREE WEEKS WITHOUT TAKING MEDICATION".

w/ "With." Substitute for the word "with." Example: For "Heat stroke w/ myocardial
infarction," type "HEAT STROKE WITH MYOCARDIAL INFARCTION".
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APPENDIX F - PLACE OF INJURY CODES

A.  Home
Excludes: Abandoned or derelict house (P)

Home under construction, but not yet occupied (G)
Institutional Place of Residence (C)

About home
Apartment
Boarding house
Cabin
Farm house
Hogan
Home for the sick
Home premises
Home sidewalk
Home swimming pool
Hospice
House (residential)
Noninstitutional place of residence

Penthouse
Private driveway to home
Private Garage
Private Garden to home
Private Walk to home
Private Wall to home
Residence
Swimming pool in private home or garden
Trailer camp or court
Yard to home
Yard NOS

B.  Farm
Excludes: Farm House and Home Premises of Farm (A)

Barn NOS
Barnyard
Corncrib
Cornfield
Dairy (farm) NOS
Farm buildings
Farm pond or creek
Farmland under cultivation

Field, numbered or specialized
Gravel pit on farm
Orange grove
Pasture
Range NOS
Silo
State farm
Ranch NOS
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C.  Residential  Institution
Almshouse
Children's home
Dormitory
Fraternity house
Institution (any type)
Jail
Nurse's home
Nursing home

Old people's home
Orphanage
Prison camp
Prison
Reform school
State school
Sorority house

D.  Military  Residence
Army Camp Military reservation

E.  Hospital
Hospital

F.  School,  Other  Institution,  Administrative  Area
Excludes: Building Under Construction (G)

Residential Institution (C)
Sports and Athletic Areas (N)

Armory
Assembly hall
Campus
Child center
Clubhouse
Church
Cinema
College
Country club (grounds)
Court house
Dance hall
Day nursery
Drive in theatre
Fire house
Gallery
Health resort
Institute of Higher Learning
Kindergarten
Library

Mission
Movie house
Music Hall
Night club
Opera house
Police precinct
Police station or cell
Post office
Private club
Public Hall
Salvation army
School (grounds) (yard)
School (private) (public) (state)
Theatre
Turkish bath
University
YMCA
YWCA
Youth center
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G.  Industrial  and  Construction  Areas
Building under construction
Coalyard
Construction job
Dairy processing plant
Dockyard
Dry dock
Electric tower
Factory (building) (premises)
Foundary
Grain elevator
Highway under construction
Industrial yard
Loading platform - factory
Logging operation area
Mill pond
Oil field
Oil rig and other offshore installations

Oil well
Plant, industrial
Power-station (coal) (nuclear) (oil)
Produce building
Railroad track or trestle
Railway yard
Sawmill
Sewage disposal plant
Shipyard
Shop
Substation (power)
Subway track
Tannery
Wharf
Workshop

H.  Garage/Warehouse
Excludes: Garage in Private Home (A)

Body shop
Garage NOS
Garage - place of work

Loading platform - store
Warehouse

I.  Trade  and  Service  Area
Excludes: Garage in Private Home (A)

Airport
Bank
Bar
Cafe
Casino
Electric company
Filling station
Funeral Home
Garage away from highway except home
Garage building (for car storage)
Gas station
Hotel

Motel
Market (grocery or other commodity
Office (building)
Radio/Television broadcasting station
Restaurant
Salvage Lot, Named
Shop, commercial
Shopping center (Shopping mall)
Station (bus) (railway)
Store
Subway (stairs)
Tourist court
Tourist home
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J.  Mine/Quarry
Coal pit
Gravel pit

Sand pit
Tunnel under construction

K.  Street/Highway
Alley
Bridge NOS
Freeway
Interstate
Motorway

Pavement
Roadside
Road
Sidewalk NOS
Named Street/Highway/Interstate

L.  Public  Recreation  Area
Beach - NOS (Private) (Named)
Beach resort
Boy's camp
Holiday camp
Lake resort
Mountain cabin
Mountain resort

Named lake
Park (any) (Amusement) (Public)
Playground NOS
Resort NOS
Seashore resort
Vacation resort

M.  Institutional  Recreation  Area
Playground, school

N.  Sports  and  Athletics  Area
Excludes: Swimming Pool or Tennis Court in private home or garden (A)

Baseball field
Basketball court
Cricket ground
Dude ranch
Fives court
Football field
Golf course
Gymnasium
Hockey field
Hunting cabin

Ice palace
Racecourse
Riding school
Rifle range - NOS
Skating rink
Sports palace
Sports ground
Stadium
Swimming pool (public) (private)
Tennis court
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O.  Other  Building
Building NOS

P.  Other  Specified  Place
Abandoned gravel pit
Abandoned public building or home
Air force firing range
Bar pit or ditch
Beach NOS
Camp
Camping grounds
Canal
Caravan site NOS
Cemetery
City dump
Damsite
Derelict house
Desert
Ditch
Dock NOS
Excavation site
Fairgrounds
Field NOS
Forest
Fort
Harbour
Hill
Irrigation canal or ditch
Junkyard
Lake NOS
Manhole
Marsh

Mountain
Named city
Named town
Nursery NOS
open field
Parking lot
Parking place
Pier
Pipeline (oil)
Place of business NOS
Pond or pool (natural)
powerline pole
Prairie
Private property
Public place NOS
Public property
Railway line
Reservoir (Water)
River
Sea
Seashore NOS
Sewer
Specified address
Stream
Swamp
Woods
Zoo
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Q.  Unspecified  Place
Bed
Commode
Country
Downstairs
Fireplace
Jobsite

Near any place
On job
Parked car
Sofa
Table
Tree
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